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Gradeßook 1.4
by

Rex Evans
840 Oak St.

Brentwood, CA 94513

( Yes, it’s free.)

Copyright

Copyright © 1992,1993 Rex Evans. This manual and the software described in it are 
copyrighted with all rights reserved. I used THINK Pascal™ to write this program, so portions 
of this program are ©1991 Symantic Corporation.

Limited Warranty on Media and Manual
Rex Evans makes no warranty, either explicit nor implied, with respect to this software, 

its quality, performance, or fitness for a particular purpose. Permission to use, copy, and 
distribute this software and its documentation for any purpose and without fee is hereby 
granted, provided that the above copyright notice and this permission notice appear in 
supporting documentation. This software is provided “as is” without express or implied 
warranty.

Introduction

Gradeßook is written for school teachers to track a class of students. The three basic 
functions of the program are to record assignments and grades, compute student grades, and 
produce reports. A spreadsheet is used as the primary method of entering and maintaining 
data. The objective was to make the spreadsheet look much like the ones used in typical grade 
books. I have attempted to make the interface as friendly as possible and hope it is intuitive.

Each class may have up to 50 students (I shure hope it never comes to that!) and 8 
subjects. Within each subject there must be at least 1 and as many as 8 sub-subjects (or 
categories, if you will). Sub-subjects provide the following functions:

• Allows the teacher to group assignments (examples: homework, quiz, etc.).
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• Each sub-subject may use a different grading method (points, letter grade, pass/fail, or 
check marks [+, •, or -]).

• A weight is assigned to each sub-subject representing the portion of the subject grade.

Each subject may have up to 40 assignments but each assignment must belong to a 
specific sub-subject. The sub-subject determines the form of grading to be used for the 
assignment. Each assignment is also given a weight indicating its portion of the sub-subject 
grade. (That's right. The assignment weight is used in calculating a sub-subject grade and then 
the sub-subject weight is used in calculating the subject grade. To avoid using weights, give 
the same weight to everything.)

Planning Ahead

Although I believe the program is easy to use, you should put some thought into how 
you want to use it. In particular, think about how you plan to use sub-subjects and what form of 
grading is appropriate for each sub-subject. The only thing you cannot do later is change the 
form of grading. This is because I don't know what to do with the assignments already 
recorded in the sub-subject.

You are allowed at any time to change the student's assignment grade, the weight of the 
assignment, the weight of the sub-subject, the point value of an assignment, the name of the 
assignment, the name of the sub-subject, the student's name, delete an assignment, etc.

If this is your first time using the Gradeßook program I suggest you create a dummy 
class and play with it.

Requirements

• Any Macintosh (I targeted the Macintosh LC).

• System 6.05 or later.

• Enough disk space for Gradeßook (~120K) and as many class files as needed (~200K 
each if all subjects are defined). Hard disk recommended.

• 2 megabytes of memory.



Page 6

I was able to install the Macintosh LC system 6.07 and the Gradeßook application on 
one high density floppy (1.4 M) and still have room for one grade book file. However, this is a 
tight squeeze and I/O is the pits.

Icons

This is the icon used for the Gradeßook program. Double-click on this icon to start 

the program. You will be prompted to select a grade book file to open or to create a 
new grade book.

A grade book file is created for each class. The file contains everything there is to 

know about the class.

Creating Your First Grade Book

• Create a back-up copy of the Gradeßook program!

• Double-click on the Gradeßook icon. You will be asked to enter the name of your school 
and its phone number.

The school name and phone number will be embedded in the program and will 
appear on reports.

• A file dialog will be displayed. Click on the 'New' button.
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• Personalize the grade book by entering the teacher, class, and room. This information 
will appear on reports.

• The assumption is that you would probably want to enter the student names next, so a 
dialog is presented. Names must be given with the last name first. As each student 
name is entered, the dialog will display the number of the next student to enter. If you 
wish, you could click on the 'Done' button and enter names at a later time. Note also 
that a date field is provided with the current date. Change it if necessary.
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Note: If you add a student at a later time, all existing assignments in the grade book will 
be flagged as excused. You can change the entries later if you wish.

• All classes have at least one subject, so you will be prompted to enter one new subject 
name.

• At this time the spreadsheet for the subject will be displayed. Since assignments cannot 
be entered without at least one sub-subject defined, you will be prompted to define one 
at this time.
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◊ Give a name to the sub-subject. It may be up to 32 characters wide.

◊ Click on the type of grading to be used for this sub-subject. All assignments in 
this sub-subject must use the selected grading.

◊ Determine what portion the subject grade the sub-subject represents by entering 
a weight. All sub-subject weights will be normalized when the grades are 
computed. To treat all sub-subjects with equal weighting, use the same value for 
each sub-subject. See the section on ‘Applying Weights’ for a full explanation.

◊ Click on the 'OK' button and the sub-subject will be added to the grade book.

• Create your first assignment by selecting 'New Assignment' from the 'Assignment' 
menu.
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◊ Describe the assignment. It may be up to 32 characters wide.

◊ Click on one of the sub-subjects. This associates the assignment to the sub-
subject and determines the type of grading for the assignment.

◊ If the sub-subject uses point grading, then enter the point value of the 
assignment. Otherwise, this field is ignored.

◊ Enter the weight the assignment will have on the sub-subject grade.

◊ The current date is provided. Change it to reflect when the assignment was given 
or due.

◊ Click on the 'ADD' button. The assignment will be added to the grade book and a 
new column will be inserted into the spreadsheet for the subject. Note that the 
column is added next to the student name column. This reverse ordering of 
assignments is to make it easy to enter the student grades. When reports are 
produced, or when the spreadsheet is printed, the columns will be in ascending 
order of assignments.
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• Enter the student grades. Note that the first cell next to the first student name is 
highlighted. Just enter the grade and press the return key. The program will move to the 
cell for the next student. At any time you may return to any cell in the spreadsheet by 
clicking on it. Whenever a cell in an assignment column is highlighted, the name of the 
student and the date, description, and type of assignment are displayed in bold text 
above the columns.

• Your grade book is now ready, but it has not been saved to disk. You may do so now or 
at any time. For this exercise, we will go ahead and create it. So, select 'Save' from the 
'File' menu. A dialog window will be displayed to allow you to name your grade book file. 
Give it a name and click on the 'Save' button.

You have created your first grade book and entered your first assignment. If this is an 
experimental grade book you may wish to try the various selections in the menu to see what 
they do. When you are done, select 'Close' or 'Quit' from the 'File' menu. If you have made any 
changes since the grade book was last saved, you will be asked if you wish to save the 
changes. If you click on 'Yes' the changes will be saved and the grade book closed.. If you click 
on 'No' the changes will be discarded and the grade book closed. If you click on 'Cancel' the 
program will cancel the 'Save' or 'Quit' and you may resume making changes.

Using the Spreadsheet

A spreadsheet is used as the main window for viewing and editing student grades. The 
spreadsheet is made up of the following parts:

Title Bar The name of the current subject is always displayed in the window’s 
title bar. When you select a different subject, the title bar is updated 
along with all information in the spreadsheet.

General Info The window will always display the teacher, class, room, and 
subject. Additionally, when one of the grade cells is selected, the 
student’s name and assignment information is displayed in bold.
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Column Headings A heading is placed above each column. Since assignment 
descriptions are too wide to place above a column, the 
assignment’s number (given in the order they are created) is used. 
An assignment key report is available for cross referencing. For a 
quick reference, select any cell in the column and the assignment’s 
information will be displayed in the General Info area.

Name Cells Student names may be edited by clicking on the cell to be changed. 
The change takes effect when you press the return key or when 
you click anywhere outside of the cell. The student’s last name 
must be given first, followed by a comma, followed by the first 
name.

Grade Cells A grade may be entered or changed by clicking on the cell and 
entering the new information. When you select a cell, the name of 
the student and information about the assignment will be displayed 
in the General Info area. The assignment information includes the 
assignment date, description, and the grading method to be used 
(points, letter, pass/fail, or check mark). If points grading is used 
then the maximum point value of the assignment is given. The 
change takes effect when you press the return key or click 
anywhere outside of the cell. If the return key is pressed, the next 
cell in the column will be selected unless it is the last cell.

Scroll Bars When there are more students than can be displayed in the 
spreadsheet, the vertical scroll bar becomes active. Likewise, as 
the number of assignments grows, the horizontal scroll bar 
becomes active. Note that the student name column is always 
visible. The horizontal scroll bar will only scroll the assignments 
section of the spreadsheet.

No checking is done to insure that a student’s name is not entered more than once in 
the spreadsheet. As for grades, they must conform to the method selected for the assignment 
or the program will not accept the entry. When a grade is not accepted, the program will inform 
you and then change the cell back to its previous contents. You can then try again.
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Notice that the assignments are given in reverse order in the spreadsheet. This was 
done to place new assignments next to the student names for easy reference. When the 
spreadsheet is printed the assignments will be given in ascending order. By the way, before 
you print the spreadsheet you may want to select ‘Page Setup’ from the ‘File’ menu and 
change the page layout to be landscape instead of portrait. I think it looks better that way. But 
it’s up to you. As many pages as are necessary will be printed to show all students and all 
assignments. The assignment key will also be printed following the spreadsheet.

You can navigate through the spreadsheet by:
◊ clicking on cells,
◊ pressing the return key to advance down a column,
◊ using the scroll bars, or
◊ using the arrow keys.

The arrow keys only work after you have selected a cell with the mouse. If the cell is a 
student’s name, then only the up and down arrow keys may be used. If the cell is in an 
assignment column, then all four arrow keys may be used. In all cases, when along one of the 
borders of the spreadsheet the arrow key will scroll the spread sheet by one column or row. 
(Notice how the student name and assignment information in the General Info area changes 
as you move among the cells!)

Entering Grades

To enter a grade for a student, find the row containing the student’s name  and then 
locate the column for the assignment. Then select the cell by clicking on it. The cell will 
become highlighted. You may then enter the grade. What will be accepted by the 
Gradeßook program is determined by the grading method used for the assignment (see 
the section on ‘Grading Methods’ for details). If the data entered is not acceptable, the 
program will inform you and the cell will revert to its previous state. In addition to the 
grading information allowed by the grading method, the following data may be entered 
for all methods:

<empty> An empty cell indicates a missed mark. Missed marks are given a 
score representing 45% of the assignment’s worth when computing 
grades.

AB Absent. All absences must be resolved before a grade can be 
computed for the student.

EXC Excused assignment; not used in the calculation of the student’s 
grade.

X Same as EXC.

The program will accept either all upper or all lower case letters.
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Teachers have also asked for a way to attach some special meaning to a grade. 
Therefore, you may surround a grade with ‘()’, ‘{}’, ‘[]’, or ‘<>‘. For example: ‘[C-]’, ‘[P]’, 
‘{73}’, ‘<•>‘. The significance of the notation is left to the teacher.

To enter a bullet (•) for a check mark grade, hold down the ‘option’ key and press the ‘8’ 
key. The bullet was selected since it is available on all fonts.

Grading Methods

The Gradeßook program supports four forms of grading. You may use any combination 
of grading within each subject. However, you can only use one form of grading within a sub-
subject. The available forms are:

Points A numerical value is given to each assignment. The value represents the 
maximum number of points available for the assignment. When computing 
grades, sub-subjects with point grades will use actual values assigned.

Letter Letter grades:  ‘A+’,  ‘A’,  ‘A-’,  ‘B+’,  ‘B’,  ‘B-’,  ‘C+’,  ‘C’,  ‘C-’,  ‘D+’,  ‘D’,  
‘D-’, and ‘F’. When computing grades, sub-subjects with letter grades will 
map the grades to the following values (scaled to 100):

A+ = 101 C+ = 78 F = 50
A = 96.5 C = 74
A- = 91 C- = 70.5
B+ = 88 D+ = 66.5
B = 84.5 D = 61
B- = 81 D- = 54.5

Total value for each letter assignment will be 12.

Pass/Fail A pass/fail or credit/no credit is represented by ‘P’ & ‘F’ or ‘C’ & ‘N’. When 
calculating grades, a pass has a value of 1.0 and a fail has a value of 0.5 
and the assignment has a value of 1.

Check Mark The symbols -, •, and + are used. The marks will map to
‘-’=0.61(D), ‘•’=0.74(C), and ‘+’=0.95(A) with a total value of 1.0 for each 
assignment. (Note: The ‘•’ is entered by holding down the ‘option’ key and 
pressing the ‘8’ key.)

The percentile mappings shown above may be changed selecting the 'Percentiles' 
option from the 'Edit' menu.
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Applying Weights

The first thing to remember when defining weights is that they will be normalized when 
computing grades. For example, if only three weights were provided and they have a value of 
5, 5, and 10, respectively, then the first two would each represent 25% of the grade and the 
third would represent 50% of the grade. 

If you do not wish to use weights, assign the same value (1 is nice) to all weights.

Assignment weights only apply to the sub-category in which the assignment is found. 
Sub-category weights only apply to the subject in which the sub-category is found.

A zero weight for an assignment is used for assignments that will not be used in 
calculating the sub-subject grade (see ‘No Credit’). Also, a zero weight for a sub-subject will 
exclude the sub-subject from the calculation of the subject grade.

A negative weight for an assignment is used for extra credit assignments. The weight is 
made positive and then used to determine the effect it will have on the sub-category grade 
(see ‘Extra Credit’).

Extra Credit

Extra credit assignments are identified by assigning them a negative weight. The weight 
should be given as a fraction of the sub-subject grade. For example, if an assignment can 
raise the sub-subject grade by at most 2%, then enter the weight as ‘-0.02’. 

For example, assume a score of 45 out of 50 was given for an extra credit assignment 
with a weight of -0.02 and assume the sub-subject grade was computed to be 83%. Then the 
final sub-subject grade would be:

83% + 100% * 0.02 * (45 / 50) = 84.8%

Extra credit assignments are accumulative. The method of computing grades only 
applies to the calculation of the sub-subject grade before adding extra credit assignments.
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No Credit

If you do not wish for an assignment to contribute to the calculation of a sub-subject 
grade, then give it a weight of zero (0.0). Zero weight assignments will be skipped when 
computing the sub-subject grades.

In the same way, a sub-subject can be skipped when computing the subject grade by 
giving the sub-subject a weight of zero.

Computing Grades

When the Gradeßook program is asked to compute grades, it will ask you to select one 
of three methods:

Percentiles are used internally by the Gradeßook program when computing grades. The 
assignment grade is first converted to a percentile. Then the method of computing the sub-
subject and subject grade are applied as follows:

Let: M = Assignment mark (grade)
W = Assignment weight
V = Assignment total value
N = Number of assignments
P = Percent of maximum grade for assignment

Straight Points: P =100×
M∑
V∑

Even Average: P =100×
M
V

×
1
N∑

Weighted Average: P =100×
M
V

×
W
W∑

 ⎛

 ⎝ ⎜
 ⎞

 ⎠
 ⎟∑
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Excused assignments are not included in the calculation. Missed assignments are given 
a value equal to 45% of the assignment’s worth.

Extra credit assignments are computed and added after the percentile is computed. The 
weight should be given as a fraction of the sub-subject grade. For example, if an assignment 
can raise the sub-subject grade by at most 2%, then enter the weight as ‘-0.02’. Each extra 
credit assignment is added as follows:

Extra Credit: P =P+
M
V

× W ×100

After the percentile grades are computed, they are mapped to letter grades as follows:
> 100 A+ 77 : 79 C+

93 : 100 A 72 : 76 C
90 : 92 A- 70 : 71 C-
87 : 89 B+ 64 : 69 D+
83 : 86 B 59 : 63 D
80 : 82 B- 51 : 58 D-

0 : 50 F

Making Changes

Almost any entered information may be changed at any time.  The only thing you cannot 
do later is change the form of grading. This is because I don't know what to do with the 
assignments already recorded in the sub-subject.

You are allowed at any time to change the student's assignment grade, the weight of the 
assignment, the weight of the sub-subject, the point value of an assignment, the name of the 
assignment, the name of the sub-subject, the student's name, delete an assignment, etc.

To change any cell in a spreadsheet, simply click on the cell to highlight it. Then enter 
the new data and press the return key. If the new data is not allowed (like in a wrong grade 
type for the assignment) the Gradeßook program will inform you and the cell will revert to its 
last value.
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Menu Choices

Apple Menu

About Gradeßook

A credits dialog is displayed.

File Menu

New

Create a new grade book. A file for the grade book is not created until you select 
‘Close’, ‘Save’, ‘Save As...’, or ‘Quit’.

Open

Open an existing grade book and display the spreadsheet for the first subject.

Close

Close the current grade book. If any changes have been made, you will be asked if you 
wish to save them.

Save

Save all changes to the current grade book to the disk file. If no file has yet been 
created, then you will be asked to name a new file for the grade book.

Save As...

The current grade book may be saved to disk under a new file name. All subsequent 
changes will be saved to the new file.

Page Setup...

Set the printing style for your printer (paper type, page orientation, etc.).  Selected 
options are used for all subsequent printing.

Print

A sub-menu provides a selection of all available reports. Available reports are:
◊ Assignments - Also available from the ‘Assignments’ menu.
◊ Class Average  - Also available from the ‘Assignments’ menu.
◊ Missed Marks - Also available from the ‘Assignments’ menu.
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◊ Missed Work - Also available from the ‘Student’ menu.
◊ Progress Report - Also available from the ‘Student’ menu.
◊ Recent Assignments - Also available from the ‘Assignments’ menu.
◊ Spreadsheet
◊ Student Grades - Also available from the ‘Student’ menu.
◊ Student Report - Also available from the ‘Student’ menu.

See the ‘Available Reports’ section for a description of each report.

Help

A on-line help package is brought up. Make a selection for more information. Click on 
‘Cancel’ to dismiss the help package.

Quit

If a grade book is open and has been modified, you will be asked if you wish to save it 
to disk before quitting. ‘Yes’ will save the changes while ‘No’ will discard the changes 
before quitting.

Edit Menu

Check-List
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A check-list is printed on every Progress Report. The check-list can contain up to ten 
lines. Selecting 'Check-List' from this menu allows you to edit the check-list. The new list 
will be used on all subsequent Progress Reports.

Clear Gradeßook

The Gradeßook program was designed to support only one school term. At the end of a 
term the grade book file should be copied and saved for future reference. At the start of 
a new term the ‘Clear Gradeßook’ option will delete all data from the grade book file 
except for student names. When starting a new school year you should create a new 
grade book file.

Percentiles

The default mappings from grades to a percentiles (see 'Grading Methods') may be 
changed by selecting this option from the Edit menu. A dialog box will be displayed and 
you may enter the new mappings.

School Name
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When the Gradeßook program is first executed, it asks for the name of the school and 
the school’s phone number. This name and number becomes embeded within the 
program.  All grade books will use this name when producing reports. This command 
allows you to change the school name and pphone number. The new name and number 
will replace the old ones within the program.

Subject Name

This option allows you to edit the name of a subject. No other information within the 
subject is modified.

Student Menu

New Student

The student name must be given last name first. Change the date, if necessary. 
Pressing the return key or clicking on the ‘Enter’ button will add the student to the grade 
book. New names are added after all existing students. All existing assignments will be 
marked as excused for the new student. You may change the assignment entries later. 
Click on the ‘Done’ button to dismiss the new student dialog window. There is a limit of 
50 students per grade book.

Delete Student
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A student can be deleted from the grade book. When this option is selected a warning 
dialog is displayed and you must acknowledge that you truly want to delete the student.

It is suggested that you save a copy of the grade book before deleting a student.

Sort Names

The ‘Sort Names’ option will sort all student records in all subjects. The names may be 
sorted by first or last name. For more than one student with the same last name you 
may wish to sort by first name and then sort again by last name.

Missed Work
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The ‘Missed Work’ option will produce a report of all missed assignments or missed 
assignments on or after a specified date. The report can be given by student or subject. 
When it is given by student and all students are selected then each student will start a 
new page. When it is given by subject and all subjects are selected then each subject 
will start a new page. The style of the report varies with the options selected from the 
dialog window. Under certain combinations of options the report can only go to the 
printer. Otherwise the report may be displayed or printed. If displayed, you can then 
click on a ‘Print’ button to print the report.

Progress Report

This report is intended to be sent home each grading period for the parent’s review and 
signature. The report gives the student’s current grade in each subject.

If the ‘All Students’ option is not selected then a dialog will be presented for you to 
select the student.

You must select a grading period and grading method. The selected grading period is 
added to the report. Finally, the current date is provided. Change the date if necessary. 
The date will be added to the report.
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A check-list is printed on all Progress Reports. the list, which can contain up to ten lines, 
may be edited by selecting 'Check-List' from the Edit menu. The edited list is 
remembered and will be used for all subsequent reports.

Student Grades

Print a spreadsheet showing the current grade in each subject for every student. All 
absences and missed marks must be resolved before this report will be produced. You 
must select a method for computing the grades when you are presented the following 
dialog:

Student Report

Display and/or print student reports. By default, all subjects, sub-subjects, and 
assignments will be listed in the report. Grades will be computed and output with the 
report unless there are outstanding absences.

If the ‘All Students’ box is checked then the reports will only go to the printer due to the 
volume of output. When printed, each student report starts on a new page. If the ‘All 
Students’ box is not checked, you will be asked to select the student.

If the ‘All Subjects’ box is not checked, then you will be asked which subject to report.

If the ‘List Sub-Subjects’ box is checked, then all sub-subjects will be output with sub-
subject grades.

If the ‘List Assignments’ box is checked then all assignments will be output with the 
student’s grade. If the ‘List Sub-Subjects’ box is checked, then the assignments will be 
grouped with the sub-subject. Otherwise, they will be listed in the order they were given.
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You must select which method is to be used to compute grades. See the section on 
‘Computing Grades’ for a description of each method. When the ‘Weighted Average’ 
method is selected, normalized weights will be added to the report.

When ‘to Monitor’ is selected, the student’s report will be displayed. A ‘Print’ button is 
added to the report’s window so you can print the report after viewing it.

Subject Menu

New Subject
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A new subject may be added at any time. There is a limit of 8 subjects per grade book. 
When a new subject is created, a spreadsheet is created and then the ‘New Sub-
Subject’ dialog is displayed (see ‘Sub-Subject’ menu). At least one sub-subject must be 
defined for each subject. Define it now or click on the ‘Cancel’ button if you want to 
define it later.

Compute Grades

Selecting ‘Compute Grades’ will calculate each student’s grades for all sub-subjects and 
for the subject. The grades are then inserted into the spreadsheet. For example, if there 
are 15 assignments in 3 sub-subjects, then columns 16, 17, and 18 will contain the sub-
subject grades and column 19 will contain the subject grade.

‘Compute Grades’ only applies to the subject currently displayed in the spreadsheet. All 
absences must be removed before computing grades. Otherwise the command will 
cancel.

Any change to the status of the subject for which grades have been computed will result 
in the computed grades being removed from the spreadsheet. Obviously, changes void 
the current calculations.

Using ‘Compute Grades’ is completely independent from the ‘Student Report’ option in 
the ‘Student’ menu. In other words, you do not need to use ‘Compute Grades’ before 
using the ‘Student Report’, or visa versa.

Select the desired method for computing grades.  See the ‘Computing Grades’ section 
above for a description of each method.

Delete Subject
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A subject can be deleted from the grade book. However, deleting a subject will also 
delete all assignments within the subject. When this option is selected a warning dialog 
is displayed and you must acknowledge that you truly want to delete the subject.

It is recommended that you back up the grade book before deleting any subjects.

<subject name>

As each subject is created, it’s name is added to the ‘Subject’ menu. Selecting one of 
the subject names will bring that subject into the spreadsheet, update the ‘Sub-Subject’ 
menu, and make all assignments available for editing.

Sub-Subject Menu

New Sub-Subject

A sub-subject (or category) is used to determine the grading method to be used for 
assignments. At least one sub-subject must be defined for each subject. A maximum of 
8 sub-subjects may be created for each subject, each one using a different grading 
method.

The sub-subject also has a weight associated with it. A sub-subject grade is calculated 
from all assignments within the sub-subject. The weight may then be applied to the sub-
subject grade when calculating the grade for the subject. See the section on ‘Applying 
Weights’ for details. The sub-subject weights will be normalized before calculating the 
subject grade.



Page 28

Give a name to the sub-subject. Then select the grading method to be used for 
assignments within the sub-subject. See the section on ‘Grading Methods’ above for 
details. Finally, give the weight this sub-subject will have on the final subject grade. 
(Note, using the same weight for all sub-subjects (1 is nice) will treat all sub-subjects 
equally when calculating the subject grade.)

The sub-subject’s name and weight may be changed at any time. However, the grading 
method cannot be changed. (What would I do with the assignments in the sub-subject!)

Delete Sub-Subject
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A sub-subject can be deleted from the grade book. However, deleting a sub-subject will 
also delete all assignments within the sub-subject. When this option is selected a 
warning dialog is displayed and you must acknowledge that you truly want to delete the 
sub-subject.

<sub-subject name>

As each sub-subject is created, it’s name is added to the ‘Sub-Subject’ menu. Selecting 
one of the sub-subject names will bring up a dialog window that will allow you to change 
the name or weight of the sub-subject. The sub-subject’s grading method cannot be 
changed.

Assignment Menu

New Assignment

The ‘New Assignment’ option allows you to add an assignment to the current subject.  A 
maximum of 40 assignments may be defined for each subject.

The assignment description may be up to 32 characters. A sub-subject must be selected 
since it determines the method of grading to be used. If point grades (scores) are to be 
used, then enter the maximum point value of the assignment. Otherwise, the points field 
is ignored. The current date may be accepted or changed.
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Each assignment is also given a weight. The weight is used to determine the portion the 
assignment is of the sub-subject grade. Suppose you give three assignments and 
decide that the first will count 30% of the sub-subject grade; the second 30% of the sub-
subject grade; and the final 40% of the sub-subject grade. Suppose that point grading is 
used and the point value of the first test is 100, the second is also 100, and the third is 
150. When you add the assignments, enter weights of 30, 30, and 40 (or 3, 3, and 4; or 
6, 6, and 8; etc. The weights will be normalized to 100%). If Rex scores grades of 
80/100, 60/100, and 120/150, then Rex’s grades are computed as the raw averages of 
80%, 60%, and 80%; and the weighting of the assignments will produce a sub-subject 
grade of:

(80%*30%) + (60%*30%) + (80%*40%) = 74% (C)

The weights are only used when computing grades using the ‘Weighted Average’ 
method. See the section on ‘Grading Methods’ above.

Assignments may also be given a negative weight. Such assignments are treated as 
extra credit. Care should be given to selecting the weight since it is not averaged with 
the other weights. The weight should be given as a fraction of the sub-subject grade. 
For example, if an assignment can raise the sub-subject grade by at most 2%, then 
enter the weight as ‘-0.02’.

Once the assignment is defined, it will be added to the subject’s spreadsheet. Student 
grades may then be entered through the spreadsheet.
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Edit Assignment

All information about an assignment may be changed except which sub-subject it is in 
and what grading method is used.

Delete Assignment
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A list of all assignments will be presented in a scrollable window. Click on the name of 
the assignment to be deleted and then click on the ‘OK’ button.

A final confirmation dialog window will then be displayed. Click on the ‘Yes’ button and 
the assignment will be deleted from the spreadsheet and the grade book.

Class Average

This option will produce a report of class averages for the current subject. Averages will 
be given for the subject, sub-subjects, and assignments. The report is output to the 
monitor. A button is then available for printing the report. Only students that completed 
the assignment are used when computing the averages.

The average for subjects and sub-subjects are given in percentiles. The average given 
for assignments is the average ‘point’ value of the assignment. Letter, pass/fail, and -,•,+ 
grades are converted to a point value for averaging. All grades are also reported as a 
letter grade.

Missed Marks
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The ‘Missed Marks’ option will produce one of two reports: all students that missed an 
assignment, or all assignments missed by a student. Based on the options selected in 
the dialog window, a list of assignments or students will be displayed. Make a selection 
and click on the ‘OK’ button. The report will be displayed in a window or printed. If 
displayed, you can then click on a ‘Print’ button to print the report.

Print Assignments

This option will print an assignment key for the current subject. The report gives the 
assignment’s column number, description, weight, grading method, point value (if 
appropriate), and sub-subject.

Recent Assignments

This option will display or print a report showing all assignments on or after a specified 
date. The assignments will be presented by sub-subject for all subjects.

Available Reports

The following reports are currently available. Additional reports will be written once I 
know what is wanted.

Assignment Key Select ‘Print Assignments’ from the ‘Assignment’ menu and a report 
of all assignments will be produced.
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Class Average Select ‘Class Average’ from the ‘Assignments’ menu and a report 
will be presented giving the class averages for the current subject, 
sub-subjects, and assignments. Only assignments for which a 
grade was given are considered.

Missed Marks Select ‘Missed Marks’ from the ‘Assignment’ menu to produce a 
report of all assignments missed by a student, or a report of all 
students that missed an assignment.

Missed Work Select ‘Missed Work’ from the ‘Student’ menu. Missed work can be 
reported by student or by subject. All students and/or all subjects 
may be reported. The report will include all missed assignments by 
student and subject.

Progress Report Select ‘Progress Report’ from the ‘Student’ menu. The generated 
report is intended to be sent home during a trimester for the 
parent’s review and signature. The current grade in each subject is 
provided along with space for additional comments by the teacher.

Recent Assignments
Select ‘Recent Assignments’ from the ‘Assignments’ menu. A 
breakdown by subject and sub-subject is given for one or all 
students. Only assignments on or after a specified date are 
included. The assignment name, date, and the student’s grade are 
included. Subject and sub-subject grades are not calculated.

Spreadsheet Select ‘Print’ from the ‘File’ menu to print a subject’s spreadsheet. 
All students and all assignment columns will be printed along with 
an assignment key.

Student Grades Select ‘Student Grades’ from the ‘Student’ menu. A dialog window is 
presented from which you must select the method of grading. A 
spreadsheet style report is then printed showing the current grade 
in each subject for all students.
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Student Report Select ‘Student Report’ from the ‘Student’ menu. A dialog window is 
presented with a variety of options. Select the appropriate options 
and click the ‘Do It’ button. If there are no missed marks or 
absences, computed grades will be included in the report.
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